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Instructor’s Notes

Tutorial Approach

This tutorial covers a lot of material in only two sessions.  This chapter shows the students how to take the very plain looking worksheets they have been creating so far and turn them into professional-looking documents.

The first session introduces the students to formatting data using different aspects of fonts, such as size, style and color.  This same section covers copying of formats and introduces them to the Format Cells dialog box, which has all the major formatting features for cells.  Students learn about cell alignment and also how to wrap text within cells and to indent text.  Cell borders and backgrounds are also covered.  This session is dedicated mostly to formatting what is done to an individual cell.

The second session is the longest and covers a broad range of topics.  The formatting shown in this section applies on a grander scale than individual cells and focuses on merging, hiding and formatting larger sections of the worksheet.  The session demonstrates Find and Replace features for formats as well as how to format the worksheet background and sheet tabs for a more distinctive appearance.  Students learn how to create their own styles and apply them to other cells to create a consistent look and appearance throughout a worksheet.  To assist with formatting large blocks of cells that are designed as a table, Excel offers the AutoFormat feature in which the user can pick from a gallery of 17 styles to apply to the table.

Towards the end of the second session, the tutorial shows methods for formatting a printout from the Print Preview window, how to create headers and footers, and how to define print areas and insert page breaks into a printed worksheet.  These skills help the students to take what they see on the screen and transform it into a printout so they can create a desired effect by determining how data in the worksheet(s) will be presented in printed form.

Formatting Worksheet Data
 MACROBUTTON ATI_Comment<--Comment-->
Formatting is the process of changing the appearance of the workbook. A properly formatted workbook can be easier to read, appear more professional, and help draw attention to important points you want to make. The formatting toolbar is the fastest way to format a worksheet. With buttons on this toolbar, you can apply a comma format, adjust the number of decimal places in a number, apply Currency and Percent formats and even quickly copy formats. 
Another option for formatting is the Format Cells dialog box.  If you select a cell or range, click Format on the menu bar and then click Cells, the Format Cells dialog box opens. Figure 3-5 shows just the first tab in the dialog box, you should introduce students to the other tabs.  There are six tabs in this dialog box, each dedicated to a different set of format properties. The tabs are Number, Alignment, Font, Border, Patterns, and Protection. A font is the design applied to letters, characters and punctuation marks. Each font is identified by a font name or type face. Fonts can be displayed in various sizes and you can even change the color of the font or the background color in the cell.

Up to this point, Excel has been formatting all the students’ entries using a style called the General format. Students will now assign specific formats and can copy formats set up for one cell or cells to others.  Be sure to go over the list of Number format categories shown in Figure 3-6.  

One way to copy a format is to use the Format Painter button. Review how to use this feature with the students. First select a cell, and then click the Format Painter button, which has a picture of a paintbrush on it. Finally, select the cell or range you wish to format and the operation is complete. To apply the same format to multiple cells, instead of a single-click you should double-click the Format Painter.  The button toggles inward and every cell or range you click from that point forward receives the same formatting.  To turn this feature back off again, just click on the Format Painter button one more time and it toggles the format painting off.  This can be very handy when there are multiple cells to format on the same or on other worksheets.  
Another way to copy a format is to drag the fill handle and click the Auto Fill Options button, and then click the Fill Formatting Only option. 

 MACROBUTTON ATI_Comment<--Comment-->
Changing Font Type, Size, Style, and Color
Working with font types, sizes and colors can make a dramatic difference in the appearance and presentation of a spreadsheet. In addition to the Font drop down list and Font Size list, you can also easily choose bold or italic styles by using the Bold and Italic buttons. These buttons work like toggles to turn these styles on or off. The Font Color button is very handy on the Formatting toolbar because when you click it a color palette appears so you can choose a desired font color.  Use Figure 3-8 to show the color palette.
Aligning Cell Contents
When you enter numbers and formulas into a cell, Excel automatically aligns them with the cell's right edge and bottom border, while text entries are aligned with the left edge and bottom border. You can control the alignment of data within a cell both horizontally and vertically. Left, Right and Center alignments can be selected using their respective alignment buttons on the Formatting toolbar. 
To align the cell's contents vertically, open the Format Cells dialog box and choose the vertical alignment options on the Alignment tab. Another formatting option is the Merge and Center option, which centers text in one cell across a range of cells. To fit a lot of text within a cell without having to expand the column width to be very large, use the text wrapping option on the Alignment tab, or even choose to indent text. You can also have Excel shrink the text to fit within the given column width you have chosen or even rotate text from -90 to +90 degrees.  It would be helpful if you could demonstrate each of these formatting options.  Use a workbook that you have previously prepared and format the cells with each of the formatting options.
Working with Cell Borders and Backgrounds
 MACROBUTTON ATI_Comment<--Comment-->
Excel provides a range of tools to format not only the contents of a cell, but also the cells themselves. The gridlines you see in Excel in a new worksheet are not displayed on printed pages. It is helpful in some cases to display borders around cells. Add a border to a cell using either the Borders button on the Formatting toolbar or the options on the Border tab in the Format Cells dialog box. Show the students how the selection they choose from the palette or gallery of borders sets that selection for the button, which is the same process used for the font color button using the color palette.  When you click the list arrow for the Borders button, a Borders palette appears showing some common choices as well as a Draw Borders button at the bottom of the Border palette gallery. The Borders button has some very common border styles allowing you to create borders very quickly, whereas the Format Cells dialog box allows you to refine choices further. 

Patterns and color can be used to enliven a dull worksheet or provide visual emphasis to sections of the worksheet you want to stress. The fastest way to apply background color to cells in the worksheet is by clicking the list arrow of the Fill color button and choosing a color from the palette. To apply a fill pattern to cells, use the Patterns tab on the Format Cells dialog box

Using the Patterns tab of the Format Cells dialog box, not only can you change the background color of the worksheet, but you can also select from a palette of patterns.  MACROBUTTON ATI_Comment<--Comment-->
Certain background patterns can overwhelm the text in some cells, so you can improve the appearance by changing the color of the pattern itself to a lighter color if you are using standard black text, for example. Have the students experiment with different combinations in class to create different effects. The color palette on the Patterns tab is the same one that is also available from the list arrow of the Fill Color button.  One advantage of the color palettes when displayed form one of the color buttons on the Formatting  MACROBUTTON ATI_Comment<--Comment-->
toolbar is that if you pause your mouse by a color, a yellow tool tip will display on the screen giving the correct name of the color.  This is helpful since so many colors are similar and there are multiple shades of each color.

Classroom Activity

Make your example worksheet available to each student.  Have each student try each of the formatting options you have presented so far.  You want to stress that they are just “trying” these things so that they will not feel any pressure to “get it right”.  The concepts will stick in their minds better if you offer them a time to try these things outs.  You might repeat this process throughout the tutorial.  Just have the students keep this sample worksheet open all the time and periodically pause long enough for them to try the different formats that you are illustrating.  
Formatting the Worksheet

 MACROBUTTON ATI_Comment<--Comment-->
Excel provides tools for formatting the entire worksheet or the entire workbook. To merge a range of cells into a single cell, you can use the Merge option on the Alignment tab in the Format Cells dialog box or click the Merge and Center button on the Formatting toolbar. To split a merged cell back into individual cells, regardless of the method used to merge the cells, select the merged cell and then click the Merge and Center button again, or uncheck the Merge Cells check box on the Alignment tab in the Format Cells dialog box. You can also hide rows or columns, which does not affect the data stored there, nor does it affect any cell that might have a formula reference to a cell within the hidden row or column. To hide a row or column, select the row or column and then choose Hide from either the Row or Column option of the Format menu or from the shortcut menu that pops up when you right click the row or column heading. To unhide a row or column, you must select the headings of the rows or columns that border the hidden area, then choose Unhide from either the Row or Column option of the Format menu or from the shortcut menu that pops up when you right click the row or column heading.

The Merge and Center button is the fastest way to merge several cells into one or to split one merged cell back into several cells. Demonstrate the use of the Merge and Center button by entering some text into a cell on a worksheet and then clicking the button.  Point out to students how this improves the appearance of the worksheet and draws attention to its purpose. 

Explain to students that they can remove some extraneous detail from their worksheets by simply hiding cells.  MACROBUTTON ATI_Comment<--Comment-->
Note how formulas are still correctly calculated even when the cells referenced in those formulas or functions may be hidden from view. This allows the reader to focus on the higher-level data and is less “busy.” Formatting changes such as these are particularly useful for managers and executives who have to review a lot of reports very quickly. The preparer of the worksheet needs the detail in order to get totals or other calculations, but from a higher level perspective viewing that detail on the spreadsheet can be extraneous, which draws attention away from the central objective of the information and is more time consuming to review.

Quick Quiz
1. The _____ number format category formatted numbers used for displaying monetary values. (Answer: d)
a. General

b. Accounting

c. Currency

d. Box b and c


2. _____ is the process of changing the appearance of your workbook. (Answer: Formatting)


3. True/False: The Format Painter will allow you to copy formatting only to adjacent cells. (Answer: False)
Clearing and Replacing Formats

Sometimes you might want to change or remove some of the formatting from your workbooks. The Undo button on the Standard toolbar is very useful for removing formatting choices you have decided you do not want to use, or you can simply clear the formatting of selected cells, returning them to their initial, unformatted appearance. Review the use of the Undo and Redo buttons with students to show them how it is possible to undo and redo multiple steps in sequence. 

To simply clear formatting, select a cell or range, click Edit on the menu bar, point to Clear and then click Formats. 
Figure 3-23 displays the Find and Replace dialog box.  Be sure to go over this dialog box with students and show them each of the options.  This might be a good time, once again, to point out the “?” in the upper right corner (which appears in most dialog boxes).  To use the “?”, click on it and then drag it to one of the elements on the dialog box.  Excel will display a brief explanation of that particular element.

If you have many cells scattered throughout a workbook that have a certain formatting you wish to change, you may want to find and replace formats for these cells all at once. Demonstrate this feature to the students and then have them practice at their desks. Click Edit on the menu bar and then click Replace. When the Find and Replace dialog box opens, click the Options << button to expand the box and display additional find and replace options. Click on the Replace tab and then click the topmost Format... button to open a Find Format dialog box, select the format combinations you wish to search for, and then click the OK button. Next, click the lower Format... button and when the dialog box opens, select the options you wish to use for replacing the formatting. Click the OK button and then the Replace All button to quickly change all the cells that meet your Find Format criteria.

When using the Find and Replace formats feature, you have the option of previewing each cell that meets the criteria and deciding whether to change it or skip over it. This can be very useful if you have many cells that have formatting in common with what you want to change, but you are unsure if you want to automatically change all of them. Perhaps you only want to change boldfaced type fonts to a boldfaced and blue colored font for column headings or section names, but you think you may have other cells in boldfaced type that are not headings or section names. To decide which cells will be changed, simply use the Find Next button which will jump to each cell in succession that meets your Find Format criteria each time you click the button. If you wish to make the replacement, simply click the Replace button. If you do not want to change the cell you are viewing, simply click the Find Next button again to move on to the next cell that meets your criteria. Though more time consuming, it does allow you greater control over what is replaced.
Using Styles

Whenever there are several cells that need to use the same format, you can create something called a style for those cells. A style is a saved collection of formatting options — number formats, text alignment, font sizes and colors, borders, and background fills — that can be applied to cells in the worksheet. Excel remembers which styles are associated with which cells in the workbook. If you modify the specifications for a style, the appearance of any cell associated with that style would be automatically changed to reflect the new style. 

Go over each of the elements of the Style dialog box which is shown in figure 3-26.
Have the students practice creating a style in class.  To create a style, click on a cell that has formatting applied to it and this formatting becomes the basis of the new style you want to create. Click Format on the menu bar, and then click Style. The Style dialog box opens and all the formatting options associated with the active cell are listed. You will give the style a name, and then you can modify the formatting options by removing or adding to the existing ones listed in the dialog box. When you are finished, click the OK button and you have created a style with a specific name. To apply a style within a worksheet, first select the cells you want associated with the style, then open the Style dialog box, choose the style name from the list arrow and then click the OK button.

When you create a style, you can also click the Merge... button in the Style dialog box to merge a style with those from other open workbooks.  MACROBUTTON ATI_Comment<--Comment-->
You can also copy styles from one workbook to another. Copying styles allows you to create a collection of workbooks that share a common look and feel.

Using AutoFormat

Excel's AutoFormat feature lets you choose an appearance for your worksheet cells from a gallery of 17 predefined formats. Rather than spending time testing different combinations of fonts, colors and borders, you can apply a professionally designed format to your worksheet by choosing one from the AutoFormat gallery. To apply an AutoFormat to a table, select a range that has a table of information in it — just some basic rows and columns of data with headings and totals will do fine. Click Format on the menu bar, and then click AutoFormat and the AutoFormat dialog box opens. Scroll through the gallery to view different table formats, click on one you want to try, and then click the OK button. Click on a cell outside of your selected range to remove the highlighting from your table so you can see what it looks like with the AutoFormat design applied to it.

 MACROBUTTON ATI_Comment<--Comment-->
The designs in the AutoFormat gallery are very useful. You can either employ the professional design that Excel provides you, or simply use it as a starting point to apply a design that is close you what you want, which you can then modify to fit your own needs.  This is a good exercise to have the students practice in class.  Using this feature can help them to rapidly format large blocks of data and then make minor adjustments to present the data the way they want to.  Skills such as this help them to create professional-looking spreadsheets quickly.

Classroom Activity

While you have the AutoFormat gallery dialog box open, ask students to consider when they would use each of these.  Ask them to answer several questions before they give you an answer.  For example, is color always a good enhancement?  Why or Why not? Could color be distractive?  Is there any reason to choose a colorful format if you are going to print the worksheet on a black and white printer?

Quick Quiz

1. A ____ is a collection of formatting options (Answer: b)
a. Font

b. Style

c. Point size

d. Header

2. If you want to replace the format of several cells, you can use the _____ command. (Answer: Find and Replace)
3. True/False:  The AutoStyle feature provides a gallery of 17 predefined formats that you can select and apply to your worksheet cells. (Answer: False)
Formatting the Printed Worksheet

This is a good feature to demonstrate in class and have the students practice.  To see how your worksheet would look printed, you can open a Print Preview window by clicking the Print Preview button on the Standard toolbar. Once the window is open, Excel displays the full page, which may be difficult to read. You may zoom in by clicking the Zoom button on the Print Preview toolbar, or when you pass your mouse over the page, the pointer changes to the shape of a magnifying glass and when you click any portion of the page Excel will zoom in. Using either of these methods again will zoom you back out, so these features toggle the image between only two zoom states. By clicking the Setup button on the Print Preview toolbar, you can change margins, orientation, center the page or set several other formatting and printing features. Show the students how to open the Page Setup dialog box by selecting that option from the File menu.

The Page Setup dialog box controls how a worksheet is placed on a page for printing. You can adjust the size of the margins, which are the spaces between the page content and the edge of the page. Most printers require a minimum margin. For example, most laser jet printers can accept all margins as small a 1/4–inch, but most inkjet printers need 1/2–inch or more. Excel's default margins are 1–inch for the top and bottom margins and 3/4–inch for the left and right margins. Page orientation determines if the worksheet is printed on the page in such a way that the page is taller than it is wide, known as portrait, or wider than it is tall, known as landscape. You may also choose to center the worksheet data on each page horizontally, vertically, or both. 

Defining the Page Setup
Page Setup also allows you to select headers and footers for a page and even select which paper size you have loaded into your printer that you want to use. Another option you have is to scale the printing of the worksheet up or down by a percentage or even force it to fit to a single page or any number combination of pages wide and tall. Explain that, while this is a useful too, you never want to fit a page in such a way that the text is too small to read.    In Page Setup, you can also set the margins to leave the amount of white space you want around the printed worksheet.
Page orientation is often very useful when printing a worksheet.  Explain that often a worksheet is wider then it is long.  Changing to landscape will provide a printout that is wider then it is long.  Landscape will allow you to see more columns then you see in portrait orientation.
Working with Headers and Footers
A header is text printed within the top margin of every worksheet page and a footer is printed within the bottom margin of every page. Headers and footers can add important information to your printouts, such as your name, the date the report was created, a report name, or even the file name and location. Based on information gathered when you installed Excel, any properties of the workbook that you may have edited, and some common formatting, Excel tries to anticipate headers and footers you may wish to use and provides several preformatted options in list boxes on the Header/Footer tab of the Page Setup dialog box. You can click the list arrow for the header and footer options and select one of Excel's suggestions or create your own by choosing the Custom Header or Custom Footer buttons on the Header/Footer tab.

Use the Margins tab of the Page dialog box to set the placement of the header and footer within the top and bottom margins, respectively. The value for header and footer placement should be less than the top and bottom margin values, respectively and needs to leave enough space to fit whatever Font Size you have chosen. If you do not do so, headers and footers can overlap with worksheet data, making portions of the worksheet data and the header or footer difficult or impossible to read.

Have the students practice creating custom headers and footers in class.  This is a feature they will use repeatedly when creating workbooks.  Excel provides several formatting buttons to customize headers or footers. There is a left, center and right section in which to enter data.  You can type in any text you like and use the Font button to format the text just as you would in a worksheet cell. The Header/Footer formatting buttons provide some common actions using built-in Excel formatting codes.  The Date, Filename and Path buttons are very handy.  People often forget what they named a worksheet or where they stored it, which is where the Filename and Path buttons become useful.

Working with the Print Area and Page Breaks
By default, Excel prints all parts of the active worksheet that contain text, formulas, or values. This behavior may not always be what you want, so you can define what is called a print area that contains only the content that you want to print. To define a print area, select the range you want to print, click File on the menu bar, point to Print Area, and then click Set Print Area. You may also decide that you want to force different sections of your worksheet to print on separate pages. You can insert what is called a page break by clicking on a cell, clicking Insert on the menu bar, and then clicking Page Break. Typically you will want to do this to a cell in the first column of your print area. If you select a cell in a column other than the first column of your print area, Excel will insert a horizontal as well as a vertical page break in your worksheet that you may not want. On the Sheet tab of the Page Setup dialog box, you may also choose rows from the worksheet to repeat at the top or columns to repeat at the left of each printed page.  Demonstrate this in class and print.  You may not want to have all the students print, but rather pass your printout around so they may see the effects without all having to send jobs to the printer at once.

Another way to set the print area is on the Sheet tab of the Page Setup dialog box. One way page breaks are useful is when you have two or more tables on a worksheet and you do not want any of them to be split across multiple pages when printed, if possible. However, some tables may just be too large to fit on one page. You could force the printout to fit on a single page, but a table could be so big that doing so makes it too difficult to read the data. When a large table is being split up over many pages for printing, repeating rows at the top and/or columns at the left of each printed page is especially helpful. This feature allows you to keep any column and row headings on each page, which will make the data easier to read across multiple pages. You want these types of headings in the top or left of the data section of the printout, and not in the header. A header does not allow you to specify rows or columns to repeat, plus it is located within the margin area, so this would not be practical anyway. 

Quick Quiz

1. A page orientation that prints the worksheet so that it is wider than it is long is called the ____ orientation.  (Answer: c)
a. Wide range

b. Portrait

c. Landscape

d. Sideways

2. You can set up a section of a worksheet to be printed.  This is called the _____. (Answer: Print Area)
3. True/False: If you have some rows of a worksheet that you would like to repeat on every page, you can click the Rows to repeat at top box in the Page Setup dialog box. (Answer: True)
Tutorial Discussion Questions

1. Ask students what they can do to apply a consistent look and feel to their worksheets or to specific types of worksheets.  What are some ways to put this into effect?  Suggestions should include creating and applying styles and/or choosing some standard AutoFormats to apply.  Files can be saved with formatting and minimal amounts of data to be used as starter files.  Ask students why a consistent look and feel is important.

2. Why is it important to have a professional-looking worksheet?  Why spend so much time with styles and formats and creating borders?  Does it make worksheets and workbooks easier to read and follow, or just clutter them up with unnecessary fluff?  What have students experienced at their jobs in regards to worksheets?  Were the worksheets formatted nicely or just laid out in the sort of General formatting that Excel provides by default?  Have they ever seen or used a worksheet that had too much formatting or was formatted in a way that was difficult to follow?


Key Terms
	Term
	Definition

	AutoFormat
	A feature that lets you choose an appearance for your worksheet cells from a gallery of 17 predefined formats

	Font
	The design applied to characters, letters, and punctuation marks

	Font name(typeface)
	The identifying name of a font design

	Footer
	Text printed at the bottom of every page

	Format Painter
	A feature where you “Paint” a format from one cell to another cell or to a range of cells

	Formatting
	The process of changing the appearance of a workbook

	Formatting
	The process of changing the appearance of your workbook

	General Format
	A format that aligns numbers with the right edge of the cell without dollar signs or commands, uses the minus sign for negative values, and truncates any trailing zeros to the right of the decimal place.

	General number format
	A format where the number display just the way you enter them

	Gridlines
	Lines in the worksheet that provide a visual cue for the layout of the cells in a worksheet

	Header
	Text printed in the top margin of every worksheet page

	Landscape Orientation
	The orientation that displays the page wider than it is tall.

	Margins
	The spaces between the page content and the edges of the page

	Page Break
	A pace in a worksheet where a new page is forced

	Page Orientation
	A specification which determines if the page is wider than it is tall or taller than it is wide

	Portrait Orientation
	The orientation that displays the page taller than it is wide and it the default orientation.

	Print area
	A specified portion of a worksheet that you want to be printed

	Print Preview Window
	A window that shows you how each page of your worksheet will look when it is printed

	Style
	A saved collection of formatting options – number formats,; text alignment; font sizes and colors; border; and background fills – that can be applied to cells in the worksheet

	Typeface
	A specific design of a set of printed characters, including letters, numbers, punctuation marks, and symbols
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